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Warranty and Software Licence Agreement 

WestDev Ltd and Number One Systems 

This document contains the WESTDEV LTD SOFTWARE LICENSE AGREEMENT which will govern the use 
of the Westdev and/or Number One Systems' products supplied with it. 
You agree to the terms of this agreement by the act of opening the sealed package which contains the storage 
media on which the software is recorded. Do not open the sealed package without first reading, understanding and 
agreeing the terms and conditions of this agreement. If you do not agree to the license conditions you may return 
the SOFTWARE for a full refund before opening the sealed package.  
1. LICENSE AGREEMENT 
Ownership of the WESTDEV / NUMBER ONE SYSTEMS' Software Package and all its constituent parts 
supplied by Westdev Ltd ("LICENSED SOFTWARE") is not transferred to the Customer. Westdev Ltd hereby 
grants the Customer a non-exclusive license to use the LICENSED SOFTWARE on a single computer 
workstation. Each computer workstation, even on a network, must have its own separately LICENSED 
SOFTWARE. 
2. OWNERSHIP OF SOFTWARE 
As the LICENSEE, you own the magnetic, optical or other physical media on which the LICENSED SOFTWARE 
is originally or subsequently recorded or fixed, but an express condition of this License is that Westdev Ltd and/or 
the copyright owner retains title and ownership of the LICENSED SOFTWARE recorded on the original media 
and all subsequent copies of the SOFTWARE, regardless of the form or media in or on which the original and 
other copies may exist. This License is not a sale of the original SOFTWARE or any copy. 
3. COPY RESTRICTIONS 
This LICENSED SOFTWARE and all accompanying written materials and all other constituent parts are the 
subject of copyright. Unauthorised copying of the LICENSED SOFTWARE, including software which has been 
modified, merged, or included with other software, or of the written materials is expressly forbidden. You may be 
held legally responsible for any copyright infringement which is caused or encouraged by your failure to abide by 
the terms of the License. 
4. TRANSFER OF LICENSED SOFTWARE 
The Customer may transfer the LICENSED SOFTWARE provided that (i) this Software License Agreement is 
transferred with the LICENSED SOFTWARE, (ii) the transferee fully accepts the terms and conditions of this 
Agreement, and (iii) all complete or partial copies of the LICENSED SOFTWARE, including copies on data 
storage devices are also transferred (or destroyed). 
5. MODIFICATION 
You may not otherwise modify, alter, adapt, merge, de-compile or reverse-engineer the LICENSED SOFTWARE, 
and you may not remove or obscure any Westdev Ltd and/or Number One Systems' Copyright or Trademark 
notices. You must use all reasonable efforts to protect the LICENSED SOFTWARE, diskettes, and documentation 
from unauthorised use, reproduction, distribution or publication, or otherwise in violation of applicable law. Please 
contact our Customer Service department if you become aware of violations of Westdev Ltd's Copyright. 
6. TERMINATION 
The License is effective until terminated. You may terminate it at any time by destroying the LICENSED 
SOFTWARE and all complete or partial copies thereof. It will also terminate if you fail to comply with any term 
or condition of this Agreement. You agree upon such termination to destroy the LICENSED SOFTWARE and all 
complete or partial copies thereof. 
7. WARRANTIES 
No warranties are expressed or implied with respect to the LICENSED SOFTWARE described, its quality, 
performance, accuracy or suitability for any purpose. In no circumstances will the copyright holder be liable for 
direct, indirect, incidental or consequential damages resulting from the use of this SOFTWARE. 
8. OTHER SOFTWARE 
The supplied disks may contain software whose copyright is owned by third parties. This license agreement shall 
apply equally to this software except where the terms of this agreement are specifically modified by the copyright 
holder(s). Such modification(s) will be included in a machine readable file on the supplied disks. 
9. GOVERNING LAW 
The Governing Law of this Agreement shall be that of England. 
Westdev Ltd will reward anyone giving information leading to successful prosecution regarding breach of 
copyright. 
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Chapter 1. Getting Started 
Installation 

Backing up your files 

If you already have Easy-PC installed, please remember to back up all your libraries, 
technology files and any other data files before proceeding with the installation of the new 
version. The installer should not overwrite any of your own named files, but it can re-
install new copies of our standard data files so if you have changed any of those files it is 
important to back them up first. If you are uncertain, check the time/date stamp on the 
file. 

Of course, backing up your data is important not only for the upgrade but also at regular 
intervals during design. 

Installation 

Installation is via the autorun setup. Insert the CD-ROM into your CD-ROM drive and 
wait a short time. The CD-ROM will run up to speed and an Easy-PC Welcome screen 
will appear. If autorun has been disabled on your computer you must execute the 
'setup.exe' program using the Start menu and Run command from the Windows task bar. 

If you are installing software downloaded from our web site rather than from CD, then 
you will simply need to run the installation program once it has finished downloading. 

The installation is the same for new and existing users alike. Existing users with versions 
prior to this latest version can install the new software over an existing installation 
without deleting the old one first. 

With the installer running, once the Welcome screen is displayed, double-click on the 
Install Easy-PC - Version 17.0 option, or click then press Run. Following the 
instructions on the screen, you should use the same Destination Folder for the Program 
Files as your existing Easy-PC program files e.g. C:\Program Files\Number One 
Systems\Easy-PC 

All other instructions should be followed until you click Finish to complete the 
installation. 

Installing Over Existing Software 

If you already have an earlier version of Easy-PC installed on your system and you wish 
to install the new version into the same folder as the earlier one, please note that you will 
then end up with both versions listed in the Windows Control Panel list of installed 
applications.  

If you don’t want the earlier one to be listed in the Control Panel, you will need to un-
install that version before you install the new one. If you install the new software into the 
same folder as the old version then try to un-install the old one, you will find that the new 
software will not run as the un-install will have removed many or all of the program files. 

If you wish to install and use the new version without removing the old one, you will need 
to install the new version into a different folder. The two versions will then operate 
independently and either can be un-installed without preventing the other from running. 
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Data Files Location 

There is a step in the Setup installation wizard that asks you where you want to place data 
files (for example, Libraries, Technology files, etc). The default is always to use the 
common documents folder, “Users\Public\Documents\Easy-PC” on Windows Vista and 
later, “Documents and Settings\All Users\Shared Documents” on Windows XP (or the 
local language equivalents) if you are installing for All Users, or into your own 
Documents folder if installing for current user only. 

Running Easy-PC 17.0 

As with all Easy-PC programs, an icon will appear in the Number One Systems folder, 
or the Start pane if using Windows 8, you may also wish to create an Easy-PC Shortcut 
icon that sits on your desktop. 

To start the program, double-click on the Easy-PC icon from the Number One Systems 
folder or the Start pane if using Windows 8. 
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Chapter 2. New Features in Easy-PC V17.0 
Introduction 

All features are categorised as being SCM specific, PCB specific or Both (relevant to both 
SCM and PCB design applications). 

New style Component Editor (Both) 

The Component editor has been reorganised; there are now several tabs in the view 
which replace previous menu commands although these can still be used if required: 

The Pin Assignments tab now holds the main grid for associating Gates and Pins to 
Schematic terminals, PCB Symbol Pad Numbers and physical Pin Names. The 
Preview windows display the Gates and PCB Symbols for the component. 

 
The Packages tab allows you to set the default package, the current package that you are 
working on and the PCB symbol associated with a package. 
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The Gates tab allows you to add/remove gates and change the order within the 
component. 

 
The Values tab allows you add, remove and edit Values in the component. 
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The All Packages button applies the Value names and Values to all Packages used for 
this component, not just the current component. 

The Properties tab allows you to change the default visibility of value positions for the 
component, and also change the component description and default reference stem. 
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Assembly Variants (Both) 

Many designs will need to be produced in various different configurations. Assembly 
Variants in Version 17 enables you to do this by allowing you to specify the different 
versions (‘Variants’) you require, and identifying which components should be present 
(‘Fitted’) in each Variant. 

 

New Variants Page of Technology File 

On the Design Technology dialog there is a new page listing the Variants in the design. 
This is where you set up your variant details and select the current variant. 

Setting up Variants 

Variants are defined on the Technology dialog and Variants page. 

 
Switch on Variants using the check box, Design Uses Variants. Once enabled, the 
buttons down the right side of the menu will be available for use. 
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Now add Variants using the Add button. 

 
Name the Variant with a name that represents its use. You can also add a description to 
give it further meaning. The Used button cannot be selected but will be checked or 
unchecked depending on whether this variants is used in the design. 

The Variants dialog will now be populated like this: 

 
The Current button sets the selected Variant as the current 'active' variant, thus updating 
the display. The variants is also displayed along the top caption bar of the Easy-PC 
framework. 

 

Fitting and Unfitting Components 

There are two methods to fitting and unfitting components: 

Component Variants dialog 

Properties dialog, Variants tab 

Both methods are acceptable although the Component Variants dialog gives you visibility 
on all the components in the design in one editable dialog. 
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Component Variants dialog 

The new Component Variants dialog on the Settings menu displays a grid of all your 
components in the design and allows you to see their fitted/unfitted state across all 
variants. 

 
Use the Fitted and Unfitted buttons to change the status of each of the selected grid cells. 
you can also drag your cursor down over multiple grid cells to change their status using 
the button.  

Double-clicking a grid cell will toggle the status of that cell. 

Properties – Variants tab 

Component Properties has a new Variants tab displayed when Variants are enabled in 
the design. From here, you can set the Fitted/Unfitted state for the selected components. 

 
Select the check box (ticked) to make the component Fitted in a variant. Uncheck the 
check box to make it Unfitted in a variant. 

Display (colours) showing Variants 

On the View menu and Display dialog (Setting & Highlights tab), you can use the check 
box and colour selection for displaying Unfitted Components. This is very useful for 
quickly identifying Unfitted Components in the current variant. 
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Variants in Custom Reports 

There are extra settings on report editing dialog, allowing you to specify which variant(s) 
should be processed for this report. 

 
<All Variants> - This will produce a single report ignoring the variant settings on 
components in the design, so any Component List added to the report will contain all the 
components regardless of whether or not they are set as Fitted or not. 

Each Variant to a Separate Report - This will produce a completely separate report for 
each of the variants in the design, output to a different report file with the name of the 
variant included in the file name so that you can tell which one is which. Within each 
report, any component list will only include those components that are Fitted in that 
particular variant. 

All Variants to same Report - This will produce the same report as the previous setting, 
the only difference being that all the reports will be output one after the other to the same 
report file. 

Only this named Variant - The report will be produced for a specific variant as named 
on the dialog. All other variants will be ignored. 

Variants Report 

There is a new report on the Reports dialog named Variants Report, showing all 
components and their fitted/unfitted state across all variants. 

Variants Report 
--------------- 
Report File    : C:\Designs\Design1 (Variants Report).txt 
Report Written : Friday, July 12, 2013 
Design Path    : C:\ Designs\Design1 
Design Title   : Variants Design 
Created        : 12/07/2013 03:41:37 PM 
Last Saved     : 12/07/2013 04:35:31 PM 
Editing Time   : 88 min 
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Units          : thou (precision 2) 
Name    Component  USA     GB      EU 
----------------------------------------- 
D1      D          Fitted  -       - 
D2      D          -       Fitted  - 
D3      D          -       -       Fitted 
D4      D          Fitted  Fitted  Fitted 
D5      D          Fitted  Fitted  Fitted 
D6      D          Fitted  -       Fitted 
Total:             4       3       4 

Other Reports showing Variants 

All reports supplied in the Reports option will now output Variants if Variants have been 
defined and applied in the design. 

Variants in the Plotting & Printing dialog 

There is now an extra drop-down list box on the Output tab of the Plotting & Printing 
dialog. This allows you to choose which variant should be used for a particular plot. 

 
For correctness, you would export manufacturing files for all Variants that you require to 
build. 

Electrical items (Pads, Copper, Tracks, etc.) are always plotted regardless of Variant, as 
all variants are assembled onto the same bare board. 

Note – if a single plot combined electrical and non-electrical layers, it is always treated as 
<All Variants>. 
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IDF Export for Variants (PCB) 

There are Exporting Variants options on the IDF dialog. These allow you to choose 
which variant(s) should be used to generate the IDF data files. This dialog is only 
available if you have purchased the IDF Export cost option. 

 
There are three check boxes which allow different selections to be made for variants: 

<All Variants> This will produce a single report ignoring the variant settings on 
components in the design, so any Component added to the output will contain all the 
components regardless of whether or not they are set as Fitted or not. 

Each Variant to separate file will export all components for each variant to a separate 
file. 

Only this named Variant will allow you to type the name of the Variant that you wish to 
export. 

Change Style of Multiple Items (Both) 

Change Layer of Multiple Items (Both) 

The Change Style and Change Layer options are now available on the context menu for 
a selection containing multiple items. This includes multiple items of the same type and 
also supports some items of different types provided they can have the same type of style 
or layer. If different types of items are selected to place on a single layer, or to change to 
use the same style, you will be asked to confirm the change in-case the selection was 
incorrect. 

If multiple items are selected for Change Layer, the only layers available will be types of 
layers that all the selected items can be placed on. 

 



16   Easy-PC V17.0 Supplement  

PDF Output (Both) 

The existing PDF output has been enhanced (this is the built-in Easy-PC PDF driver). 

• Bookmarks have been enhanced to include bookmarks for Components, 
Component Pins, Net Nodes, Blocks, Block Pins and Net Nodes on each PDF 
page. 

• Popup menus have been added for Blocks and Block Ports which are similar to 
the popups for Components. Additionally for Blocks, there is a Push Into 
Block command which allows a jump to the page which has the block circuit. 

The PDF setup dialog has been changed. 

 

‘Paste Again’ feature (Both) 

There is a new option on the Edit menu, Paste Again. After performing a Duplicate or 
Copy and Paste in the design it appears as available. It is also available on the shortcut 
menu when appropriate. 

Use it to paste another copy of the data using the same offset as with the last pasted item 
from its original item but now offset from the last pasted item. 

If Online DRC is enabled and the pasted item is in error, you will be asked if you want to 
keep it. If not, the next Paste Again will offset the next copy again. 
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Delete Segment (Both) 

The Delete Segment command (assigned to the <Backspace> key, can be used in select 
mode to remove selected segments within a single track, Schematic connection, copper 
shape or documentation shape. This has exactly the same behaviour as the normal Delete 
function but only affects the selected segment(s). 

 
Deleting a segment from a closed shape will make it open. 

Deleting a segment from in the middle of an open shape or track will split it into two 
shapes or tracks. 

Splitting a schematic connection in two on an auto-named net will introduce another auto-
named net for one half to avoid split subnets on auto-named nets.  

You cannot delete a segment of poured copper, or any shape with a cutout. 

Frame Select - Only for Right-to-Left Selection (Both) 

There is an extra check box, Only for Right-to-Left Selection, on the Preferences dialog 
for Schematics Interaction and PCB Interaction. 

This is a subsidiary check box of the existing Only Select if Completely Framed check 
box. When checked, if you draw your frame-select box right-to-left then it will only select 
items completely inside the frame, whereas drawing the frame-box left-to-right will do 
normal selection of items which are partly or wholly inside the frame. The default setting 
for this check box is Off (allowing frame selection of completely framed items in both 
directions). 
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Ignoring Pads in the Name Pins by Row/Col option (Both) 

There is now an extra setting on the Name Pins by Row/Col dialog (Ignore Last Pads) 
on the Edit menu within the Component Editor. This dialog is also available on the 
shortcut menu on the Pin Assignments page and on the Component Design toolbar. 

You can specify the number of pins to be ignored from the ‘end’ of the sequence of pads 
in the PCB symbol. This can be used for example where you have used the last couple of 
pads as mounting holes and don’t want those to take part in the calculation of row/column 
names. They will be ignored during the alphanumeric naming sequence and will instead 
be given straightforward numeric pin numbers to match their PCB symbol pad sequence 
number. 

 

Using Change Net to force Auto-Named Net (Both) 

When performing Change Net or Properties on a single user-defined net, you can now 
delete the net name to force use of an auto-generated name. 

 
When doing this in a Schematic design, and the net has two or more separate subnets, 
each subnet will be put on its own separate auto-named net. 

If you are changing a net name in a Schematic project that is across multiple sheets, and 
you are not renaming a subnet, then you will be warned that only the net in the design 
being edited will be auto-named. The same net in the other sheets will retain the original 
name because you cannot have an auto-named net across multiple sheets. 
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New Folders dialog for data files (Both) 

There is a new Folders dialog, available under the Settings menu and Folders. This 
allows you to create a folder search list and enable/disable folders and files within these 
folders. Files covered are: Colour Files, Libraries, Report Format Files and 
Technology Files. 

 
All places where access to these files (e.g. Technology file on File menu and New) was 
previously done using a separate directory name have been changed to a single drop-down 
list. This shows all enabled files in all enabled folders for the particular file type. 

 
The Edit button on the Technology Files tab enables you to quickly select a Technology 
file from the Files Found: list and to edit it. Once edited, it can be saved for use. 

  



20   Easy-PC V17.0 Supplement  

Changes to Goto Bar (Both) 

Additional commands have been added to the Goto bar: 

• A new category has been added, Net (By Net Class) – this shows a list of Net Class 
names that are used in the design. Select a name to find each net (or sub net) in the 
net class. 

 

• The category Component (By Value) has been renamed to Component (By Value 
Name) 

• A new category has been added, Component (By Value Contents) - this is like By 
Value Name except it lists all the different values it finds in the form 
<name>=<value>. This will make it easier to select all components that have a value 
of 4.7K for example.  

• When using the category Design, all entries in the list now have a tooltip showing 
the complete path of the file.  

 

• For any category, if the list is too narrow to show an item in the list it will have a 
tooltip with the full text. 

 

• The tooltip for filter button now includes the filter text string. 

 

• New context menu switches have been added for: Include Schematics Only 
Components, Include Items in Component Bin and Include Suppressed 
Components. When selected, they allow you to exclude these items from the find. 
They are available for all component and pad type categories. If you switch them on 
they will act like they did in previous releases.  
Unchecking the Include Suppressed Components option will not find any 
components that are suppressed from the parts list output (as defined in the 
Component Properties dialog). 
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Grid drawn as small crosses (Both) 

There is a new check box on the Grids dialog that enables the screen grid to be drawn 
using small crosses instead of single dots. 

 
The result is small crosses in the design, this makes them easier to view in the design. 

 

Read Value Names from Technology File (Both) 

On the New dialog from the File menu, the Technology file box is now enabled for 
Components. This allows a Schematic Technology file or PCB Technology file to be 
used as source of Value (Attribute) Names when creating new Components. This is to 
allow you to use pre-defined value names for values in components rather than having to 
type them in again. 

 
If you design Schematics using multiple Technology files, then you could create yourself 
one master Technology file containing all your used Values. 

  



22   Easy-PC V17.0 Supplement  

Apply Vias (PCB) 

The Apply Vias option will add vias, either around, or on the selected shape. Remove 
Applied Vias allows you to remove the vias again. 

 
Choose where to place the vias. Around outside means placing vias in all possible legal 
positions around the outside of the selected shape and on the net given. This is ideal for 
shielding a track or other item. 

 
On the shape means along an open shape, such as a track, or along the edge of a closed 
shape. This could be used to ‘staple’ an item to a power plane.  

Vias can be added outside a track to add shielding: 
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Around inside means inside the edge of a closed shape.  

 
Fill the shape means cover the interior of a closed shape with vias. 
Select or enter the Net Name to which the vias will be added. Leaving it blank creates a 
default net. If you select an item already on a net, and you are adding vias on the shape, 
then the net is already determined and you will not need to select a net. 

Specify the Via Style to use (this is initialised to the default for the selected net). Vias 
styles would have been defined in the Pad Styles dialog.  

You can optionally define the Spacing between vias, if you don't, it defaults to the Via 
Spacing rule. If you edit the value, it can be any positive value.  

When placing around a shape, the Spacing to vias is the spacing between the selected 
item and the vias. This should be at least the Via to Item spacing defined in the Spacing 
Rules, but can be larger. 
Checking the Use Rules box means the Via to Shape spacing rule will be used.  

If you are placing vias to fill a closed shape, you can choose to Stagger them to give a 
closely packed array. 

       
The picture above shows both Normal via distribution and Staggered. 

The Random option will randomly distribute the vias, so there will be no regular pattern. 

 
Fix Vias will lock the added vias against moving, or removal by tools such as Unroute 
Nets. 
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Vias can be add along a track: 

 
Press Add Vias to add the vias to the Shape or Track. 

Save Settings will save the current settings, and use them to prime the dialog, where 
appropriate, next time it is used.  

Cancel exits the dialog without doing anything. 

Remove Applied Vias 

This command removes vias added by the Apply Vias Command. If you are removing 
from around the shape, you need to specify the net these vias are on. 

 
Select All matching to remove all suitable vias across the whole design, not just from 
around the selected shape. 

Selecting <Any Net> will remove suitable vias within range of the selected shape, 
regardless of the net. 

Remove Fixed Vias will remove vias which are locked, as well as the unlocked ones. 
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Headup Display (PCB) 

There is a new interactive PCB tooltip based headup display to show track and net lengths 
as you add and edit track segments to the design. 

This is available from the shortcut menu when using Edit Track, Mitre Corner and 
Move on track segments. 

The display will also include rules from the Net Class if they are set up. The values in the 
headup display will change to red when the rule has not been met. There is also an option 
on the shortcut menu to reposition the headup display relative to the moving cursor. 

There are some options in the Preferences dialog and Display page to control how 
unrouted connections are treated when working out the track length of a net. 

 

 
Using the Headup Display 

Check the Show Headup Display box to show a tooltip based headup display of track 
and net length information when adding, moving or editing tracks.  
If the track being edited lies on a single path between two component pads, the names of 
the pads are included at the top of the headup display. 

 
If minimum and maximum track length rules are defined on the net class of the track 
being edited, their values will be included in the display and will be drawn green if the net 
track length is within the defined limits. If the net track length is outside one of the limits 
it will be drawn with red text as well as the rule that failed.  

If the net being edited belongs to the same net class as other nets, and the net class has a 
Maximum Track Length Difference rule defined, the shortest and longest net lengths 
will be shown. If they are different, the difference between them will also be included 
along with the maximum rule limit. If the actual difference in net track lengths is greater 
than the limit it will be drawn with red text as well as the rule value.  
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Check the Include Unrouted Lengths box to include unrouted connections in the overall 
net track length. Choose the Method to be used when calculating the estimated track 
length for each unrouted connection. Manhattan is the minimum distance from one end 
of the connection to the other using just horizontal and vertical lines. Mitre is the 
minimum distance from one end of the connection to the other using horizontal, vertical 
and 45 degree lines. Point to Point is the length of the single straight line between the 
two ends.  

You can also specify an offset here, which is the distance between your current cursor 
position and where the headup display is drawn. You can change the value here to 
anything between 0 (no offset) and 4000 (4 inches). 

Create Fanout Pattern (PCB) 

In the PCB design editor, within the Tools menu, there is a new option on the Auto 
Fanout submenu. Using the Create Fanout Pattern option you can add simple fanout 
patterns to an existing selected component (for example a PGA or BGA). The fanout will 
consist of a 45-degree angled track ending on a Via, for each surface mount pad on the 
selected component. 

 
A dialog is displayed allowing you to choose the type of fanout pattern. 
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Define the X and Y offset of the fanout relative to each surface mount pad. You can 
reverse the direction by specifying positive or negative values. 
Radiate from centre causes the direction of the fanout to be determined from the position 
of the pad relative the centre. The centre is defined as the centre of the bounds of the 
component, or with the Use Pad Extents option checked, the extents of just the pads. The 
X, Y offsets defined are adjusted accordingly. 

Apply to Selected Pads Only, when checked, will add fanouts only to the selected pads. 

Apply to Connected Pads Only, when checked, will add fanouts only to pads that are 
connected. 

Select the Track Style and Via Style to use. 

Press Apply to generate the pattern without leaving the dialog. 

 

Online DRC (PCB) 

Online DRC now checks the selected items when you press Apply or OK in the 
Properties dialog. Previously it did not do this. 

Additional checks on DRC dialog (PCB) 

DRC now reports silkscreen outlines which overlap the board outline. A Silkscreen 
Board Overlap option has been added to the Manufacturing section of the Design 
Rules Check dialog. 
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Can Drill Out Pad 

You can now mark a Symbol Pad or Free Pad as Can Drill Out Pad. These are often 
used as a mounting hole. This means the minimum annular ring check (defined in 
Technology dialog and Rules) will not flag this pad if the whole pad is drilled out when 
running Design Rules Check. 

 
Allow Via In Pad 

A Symbol Pad or Free Pad can be marked as Allow Via In Pad using the check box on 
the Properties dialog.  The Via In Pad design rules check will not report an error for 
these pads. 

 

Check Against Same Net in Spacings dialog (PCB) 

The new Check Against Same Net option on the Spacing tab of the Technology dialog 
means that for all nets items on that net must either be touching or more than the Spacing 
Rule distance apart. 
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Auto-Rename Changes (PCB) 

Auto-Rename selected board 

There is an additional option on the Auto Rename Components dialog to allow 
renaming components only within the selected board outline(s). 

When multiple board outlines appear in the design, you may choose how to apply the 
rename strategy. Use Rename each board separately to rename within each board fully 
before moving to the next, or Rename all boards together to treat them as one outline. It 
maybe that you have included multiple designs in one design file or that you are making a 
'flexi-rigid' style of PCB in which case multiple board outlines would be used for the same 
design. If you have multiple board outlines in the design, you may also choose Selected 
board only to specify the ‘container’ for the Rename. 

 

Auto-Rename from file 

From the Auto Rename Components dialog it will now allow renaming components 
from a changes file, this can specify the original name and the new changed name. This 
enables you to use a file to drive the rename process.  

 
Select the radio button Using Rename List from file, and choose the file you want to 
load. Press the OK button to implement the changes. 
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The file should be a simple text file, with each line specifying the old (existing) 
component name and the new name, separated by comma, semicolon, space or tab. 
For example: 

U5,IC19 
U9,IC20 
CX9,C21 

Auto-Rename use Placement origin 

When the Placement Origin is defined on a component in the design, the Auto-Rename 
option will use this when working out which strip a component belongs to. If it isn’t 
defined, it uses the centre of the placement extents as before. 

In the example below, the Placement Origin +P has been set as an offset to the component 
centre, this would now be used during Auto-Rename. 

 

Layer Colours shown on Layers Bar (PCB) 

On the Layers Bar a small coloured block is now drawn in the layer colour (taken from 
the Technology dialog and Layers). Colours cannot be edited from here but it does show 
the layer colour used in the design. 
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Micro Library 6 (Updated Cost Option) 

An additional 218 new micro controllers have been added to the existing Micro-controller 
library, these are for Atmel AVR32, Atmel Arm Cortex and Xilinx Zynq-7000 parts. If 
you have purchased any previous versions of this library already, we can supply this 
update to you for a small upgrade charge when you upgrade to Easy-PC 17. 

AtmelAVR32 
 

120 Atmel AVR 32 microcontrollers 

AtmelArmCortex 
 

80 Atmel ARM Cortex processors 

Xilinx_Zynq-7000 18 Programmable system-on-chip including dual ARM Cortex 

 218  

Pro Library 6 (Updated Cost Option) 

The Pro-Library has been updated to include over 15,700 additional Parts and their 
associated Symbols and Footprints. This takes the contents of the Pro-Library to just over 
82,649 Parts! If you have purchased any previous versions of this library already, we can 
supply this update to you for a small upgrade charge when you upgrade to Easy-PC 17. 

Altera3 148  
Altera4 63  

ATXMEGA 172  

LT4 872  

Panasonic1 2,999  

Panasonic2 2,394  

Panasonic3 2,143  

Ti4 1,717  

Ti5 2,573  

Ti6 1,882  

Toshiba 119  

Tyco 862  

 15,743  

 

Note: for all updated library contents, the exact quantity may change slightly from the 
numbers above at the time of release. Please use the Library Finder page on our web site 
to check for any required parts. E&OE 

Using the Library Searcher for updated library contents 

A list of the updated contents can be located on our web site in the online library searcher 
www.numberone.com/libfinder.asp Select Micro or ProLib in the Library: drop down 
list, then type 6 into the Version: box. 

 

http://www.numberone.com/libraries.asp
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